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Welcome to Quick Blogcast. 
Quick Blogcast is a remarkable tool that helps you create a quality blog and podcast site. 
As you become familiar with all that Quick Blogcast has to offer, you’ll be amazed at how 
quickly and easily you can build your own unique blogcast site. 

Quick Blogcast includes everything you need to:

Create a professional blog.

Easily record and upload podcasts to share with visitors to your site. 

Allow visitors to subscribe to your blog entries and podcasts.

Include RSS feeds, Twitter links, Flickr, and many other services.

Customize your site to suit your taste.

What is a Blogcast?
A blogcast is simply the combination of a blog and podcast into a single Web site. A blog 
is a weblog, or journal, that is available on the Internet. A podcast is an audio or video file 
that you share with visitors or subscribers to your site. Quick Blogcast enables you to eas-
ily create both; you don’t have to choose one or the other. Additionally, with Quick Blog-
cast, you can freely add text, photos, and music to your blogcast entries.

SETTING UP YOUR ACCOUNT
The first step to get started is to set up your account. You need to enter some basic infor-
mation and specify the domain name you want to use for your Quick Blogcast site. 

To Set Up Your Account
1. Log in to your Account Manager.

2. In the My Products section, select Quick Blogcast.

1. Getting Started with 
Quick Blogcast
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3. Click Setup Account next to the account you want to use.

4. To accept the End User License Agreement terms of use, click Accept.

5. From the Create New Blogcast Site page, enter the following information:

Display name
Enter your name as you want it to display on each entry you post.

Email
Enter your email address.

Domain
Select one of the following options:

Create a new subdomain
Enter the subdomain prefix and select one of the domains in your list.

Select an available domain from your account
Select from the list of available domains already associated with this account.

Enter a domain not registered here
Enter the full domain name. For example, www.coolexample.com.

6. Click Save.

You have set up your blog. We sent a user name and password to the email address you 
provided. You can now update your author information or start designing your blog site.

Fig. 1.1 - Open link in your Account Manager. 

Fig. 1.2 - Create New Blogcast Site page. 
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To Update Your Author Information
1. From the Manage Blog menu, select Author Information.

2. Click Edit next to your Display Name.

3. Edit the author information in the following fields:

First Name and Last Name

Enter your first and name.

Display Name

Enter your name as you want it to display on each entry you post.

Email Address

Enter your email address.

User Name

Enter a user name.

Password and Verify Password

Enter and verify a password.

To Design Your Blogcast Template
1. Select the Templates tab.

2. In the Blog section, click Change Template to activate the Template Selector.

NOTE: If you have not yet assigned a Blog Template, click the Dash-
board tab, and then click Assign in the Quick Blogcast section. The Site 
Links page displays, where you can select the Quick Blogcast site you 
want to assign to your Dashboard. Click the Templates tab to return to 

the Templates page. 

Fig. 1.3 - Locate and click a template you want to apply. 
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3. In the Available Templates area, you can do one of the following, and then click a 
template thumbnail to select it: 

Scroll through the templates available in the Category you previously selected 
during setup. 

Click Filter and complete the following for a more advanced search: 

Category
Select a category that best describes the type of site you want to build.

Templates that work with
Click the icon(s) that represent the product(s) for which you want to use the tem-
plate, and then click Update. For example, if you want your Blog site to match 
your shopping cart, select both Site and Store so only templates that work with 
both display

4. In the Available Templates area, change the color scheme of your template by 
clicking one of the color swatches next to the thumbnail of the template. 

5. Click OK.

If you want to update your template, you can return to the template designer 
at any time by selecting Templates from the Design menu.

Fig. 1.4 - Select a color theme. 
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GETTING HELP
After you set up your account, you can always find help in the Help Center.

To Access the Help Center
1. Log in to your Account Manager.

2. From My Products, select Quick Blogcast Accounts.

3. Click Setup Account next to the account you want to work with.

4. From the Help menu, select Online Help.

The Help Center, which is a knowledge base with the most current informa-
tion, opens in a new window.

5. Under Select Your Product, click Site Builders, and then select Quick Blogcast.
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After you have designed your Quick Blogcast site, you are ready to begin adding entries. 
With Quick Blogcast you can add entries consisting of text, audio and video podcasts, and 
images. You can even combine these elements in a single post. 

Quick Blogcast offers a variety of ways you can interact with your blogcast site. For 
instance, Quick Blogcast supports remote blogging and blogging by email. Let’s examine 
the most common way of adding an entry to your site.

ADDING A BLOG ENTRY TO YOUR BLOGCAST

To Add a New Entry
1. From the Manage Entries menu, select New Entry.

2. In the Title field, type the entry title.

3. In the Categories field, enter a category. Alternatively, you can add and select a 
recurring category from the categories section on the left. 

4. In the Tags field, enter a tag. Alternatively, you can add and select a recurring tag  
from the tags section on the left. 

2. Adding Content to 
Your Blogcast Site
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5. Enter the body of your entry in the text area. You can use the formatting tools at the 
top of the text area to format your entry.

6. From the Entry Settings toolbox on the left, you can configure your entry settings in 
the following ways:

Status
Select whether you want to save the entry as a Draft or to Publish it when you click 
Save. Saving in Draft status is helpful if you want to create an entry, but are not ready 
to have it display on your site.

Timestamp
Enter the date and time that you want to display in the time/date stamp.

Comments Status
Select if you want to allow comments and set the default status of comments made to 
Open or Closed.

Allow Trackbacks
Select if you want to allow trackbacks and set their status as Open or Closed. Track-
backs let you know if someone is linking to your article.

Outgoing Trackbacks
Enter one or more URLs that you want to notify of the creation of your entry. You can 
ping (notify) other blogs that you refer to in your entry or online blog directories. 

Permalink
Specify the name you want to use for the permanent link to this blog entry. If you do 
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not specify a Permalink name, Quick Blog assigns a name after you save the entry. 
The Permalink name cannot be edited after the entry is published.

7. From the Categories toolbox you can add and select categories to organize your 
entries, so you do not have to manually enter a category for each entry.

 To add a category, type the name of your category in the text field and click Add. 
The category displays under the entry box. You can repeat this process to add addi-
tional categories. 

 To assign an entry to a category, click the category you want to use from the cate-
gories toolbox. The category displays in the Categorized field, under the Title field.
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8. From the Tags toolbox you can add and select tags to organize your entries, so you 
do not have to manually enter a tag for each entry.

 To add a tag, type the name of your tag in the text field and click Add. The tag dis-
plays under the entry box. You can repeat this process to add additional tags. 

 To assign an entry to a tag, click the tag you want to use from the tag toolbox. The 
tag displays in the Tags field, under the Title field.

9. In the Excerpt toolbox, you can enter or paste an excerpt from your entry. This 
excerpt displays on the blogcast page under the title of your entry.

10. Click Save.
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ADDING A PODCAST
Quick Blogcast has found a creative way to merge blogs and podcasts, including the post-
ing of both audio and video. Podcasts are added to your site in much the same way a blog 
entry is added. In fact, the procedure is essentially the same.

There are two ways in which to add a Podcast to your site. You can upload an existing file 
to Quick Blogcast or you can create a podcast using our Quick Recorder.

What Are ID3 Tags?
Before we add our podcast, let’s explore ID3 tags. ID3 tags allow information such as the 
title, artist, album, track number, or other information about the file to be stored in your 
podcast file. This information is available to the listener and can be displayed on most 
MP3 players. Including this information also allows your podcast to be indexed by search 
engines and iTunes.

To Upload a Podcast to Your Site
1. From the Manage Entries menu, select Add Podcast.

2. Click Browse and select your podcast file.

3.  Click Upload.
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4. Enter ID3 tag information by completing the following fields.

Subtitle
Enter the subtitle of your podcast episode. Often, the subtitle explains the main title.

Composer
Enter the composer's name. This can be the podcaster’s name, or the author of a 
book or music.

Album Info
Enter information you want to include about the album the file is from. This entry is 
not necessary if the entry is not part of a larger compilation of work.

Podcaster
Specify the name of the person who created the podcast.

Podcast Summary/Description
Enter a summary of the podcast or comments you want to include about it.

Copyright Message
Enter copyright information for the podcast. Typically this includes the word “Copy-
right,” the year of publication, and the name of the owner of the entry. 

Keywords
Keywords are words that explain or summarize your entry. Keywords help direct 
search engines and directories to your entry or blogcast site. Keywords should be sep-
arated by a comma.

Explicit
In the explicit drop-down box, you can select whether or not to mark your entry as 
containing explicit content.

You can set ID3 tag settings for each individual podcast, or set the ID3 tag set-
tings to apply to every podcast published to your site. To make the ID3 infor-
mation apply to each future podcast, select Use as default for ID3 tags at 
the top of the ID3 settings list.
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5. Click Save.

Congratulations! You have successfully added a podcast to your blogcast site. 

You can also record a podcast directly to Quick Blogcast using our Quick Recorder, our 
fully-functional podcast recorder. However, you first need to install it on your computer.

Currently, Quick Recorder is only available for PC users.

To Install Quick Recorder on Your Computer
1. From the Manage Entries menu, select Add Podcast.

2. Click Install Recorder.

3. Click Install. The Application Install - Security Windows displays.

4. Click Install.

To Create a Podcast with Quick Recorder
1. Open Quick Recorder.

2. On the Sound Settings tab, you can enable the following options:

Vocal Compression

Enables vocal compression for your recording. Select Low Compression or High Com-
pression.

Mic Boost

Doubles the volume of the sound coming into the recorder.

Phase Shift

Adds a phasing effect to your recording.

3. Adjust the level of sound going into the recorder using the gain fader slider located 
below the File menu. 

4. Click Record (red circle).
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5. In the File name field, enter a title for your recording and click Save. Quick Recorder 
starts recording.

6. When you are finished recording, click Stop (green square). 

To hear your recording, click Play (green arrow). 

The gain fader on the left side of the recorder adjusts the input level. It does 
not adjust the output volume.

After you’ve uploaded or created content, you are ready to publish your entries to the 
Internet so they can be enjoyed by visitors to your site.
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You can add as many new entries to your blogcast site as you want. However, the entries 
do not display on the Internet until you publish them. You can publish specific entries, 
leaving others unpublished. You can also remove entries from your site; this is referred to 
as deleting your entry. A deleted entry no longer displays on your site, but is easily recov-
erable. This feature gives you the ability to archive past entries and re-publish them at a 
later time.

MANAGING ENTRIES
From the Manage Entries page, you can quickly manage your site content. You can work 
with one entry or multiple entries. To perform an action, select the checkbox to the left of 
the entry or entries to which you want the action to apply, and then perform the update. 

To Publish a New Entry
1. From the Manage Entries menu, select Entries.

2. On the Manage Entries page, there are two search options to sort your entries in the 
Entries list.

View
Select a Month/Year from the Month Search drop-down list and click View.

Search
Select whether to search the Title, Title and Contents, Category, Status, or Author, 
then enter a keyword, and click Search. 

3. Managing Blog Entries
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3. Publish entries by doing one of the following:

 Click the publish icon next to the entry that you want to publish.

 Use the checkboxes to select the entries you want to publish, and then select 
Publish Entries from the Select Action drop-down menu and click Apply.

In the Display select box, you can select to display 10, 20, 50, or 100 entries 
per page. If there is more than one page, change pages by selecting a differ-
ent option from the Showing menu.

To Delete an Entry
Deleting an entry removes the entry from displaying on your blogcast site. It does not 
remove the entry from your account. The entry can be recovered at any time from the 
Manage Entries page.

1. From the Manage Entries menu, select Entries.

2. In the Entries List, locate the entry you want to delete.

3. There are two search options to sort your entries in the Entries list.

View
Select a Month/Year from the Month Search drop-down list and click View.

Search
Select whether to search the Title, Title and Contents, Category, Status, or Author, 
then enter a keyword, and click Search. 

4. Delete entries by performing one of the following actions:

 Click the delete icon next to the entry that you want to delete.

 Use the checkboxes to select the entries you want to delete, select Delete Entries 
from the Select Action drop-down menu, and then click Apply.
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To Recover a Deleted Entry
1. From the Manage Entries menu, select Entries.

2. From the Search menu, select Status.

3. In Search field, type Delete, and then click Search. A list of deleted articles 
displays.

4. Use the checkboxes to select the entry(ies) you would like to recover.

5. From the Select Action menu, select Publish Entries.

6. Click Apply.

MANAGING COMMENTS
Comments make your site interactive by allowing visitors to share their thoughts on your 
posts. Quick Blogcast allows you to manage comments in various ways. 

With Quick Blogcast, you can choose to view all or a portion of the comments submitted 
to your site. To view a certain type of comment, use Quick Blogcast’s filtering option.

To Filter the List of Comments
1. From the Manage Entries menu, click Comments.

2. From the View list, select one of the following and then click view.

All
View all comments.

Pending Approval
View all comments that are pending approval.

Approved
View all approved comments.

Spam
View comments that were marked as spam.

Deleted
View deleted comments.

Showcased
View showcased comments. Click View.
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The Manage Comments page displays the type of comments you have chosen to view.

Viewing Comment Contents
In the Comments list, you can select to display 10, 20, 50, or 100 entries per page. If 
there is more than one page, change pages by selecting a different option from the Show-
ing menu.

To View Comments
1. From the Manage Entries menu, click Manage Comments.

2. Click the expand icon next to the title to view the content of the comment.

3. Click the entry title the comment is associated with to open the entry in the Entry 
Editor.
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Managing Comments
From the Manage Comments page, you can approve or delete comments, ban IP 
addresses, or mark comments as SPAM. 

To Manage Comments
1. From the Manage Entries menu, select Comments.

2. Select the comments that you want to manage using the checkboxes located to the 
left of each comment.

3. From the Select Action menu, select one of the following options.

Add to Showcase
Adds the selected comments to the Showcase. When a visitor click on the sidebar 
Showcase link, the selected comments display on a new page. To enable this, you 
must activate the Showcase component from the Sidebar page. 

Approve Comments
Approves the selected comments, allowing them to be read by your site visitors.

Ban IP Address
Blocks a specific authors from commenting. This is done by detecting the author’s IP 
Address and blocking future submissions from that address.

Delete Comments
Deletes selected comments.

Mark Comments as SPAM
Marks the selected comments as SPAM.

Print Selected Comments
Prints the selected comments.

Remove from Showcase
Removes the selected comments from the Showcase.

From the Manage Comments page, you can easily organize and manage the comments 
submitted to your site. Enjoy!
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CUSTOMIZING YOUR TEMPLATE
The Quick Blogcast Customize Template page gives you the tools to completely customize 
your blog site and easily create the site you want. 

Let’s take a look at how to customize your blogcast site.

To Customize Your Template
1. From the Design Blog menu, select Customize.

2. Update the information you want to change on the following tabs:

Colors
Make changes to the look and feel of your template. For more information, see Set-
ting Colors for Your Blog below.

Template Images
Make changes to the images your template uses. For more information, see Changing 
Template Images below.

Header/Footer
Change your site's header and/or footer. For more information, see Changing Your 
Blog's Header and/or Footer below.

CSS Styles
Make changes to the template's CSS. For more information, see Customizing Your 
Template Using CSS below.

4. Customizing Your 
Template
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3. When finished, click Save.

Your newly designed site is now ready to be enjoyed by visitors.

Setting Colors for Your Blog
1. From the Design Blog menu, select Customize.

2. Select the Colors tab.

3. In the following fields, edit the elements you want to change:

Select Element
Select an element of your template that you want to customize. Edit the selected ele-
ment using the following options:

Font/Foreground and Background
Specify if you want to edit a font/foreground color or background color, using the 
color picker.

Font Style and Font Size
Select a different font and/or size for the selected element.

Select Color
Using the color picker, select a color for the selected element.

4. To preview your changes, click Apply Changes / Update Preview.
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5. To publish your changes, click Save.

Changing Template Images
1. From the Design Blog menu, select Customize.

2. Go to the Template Images tab.

3. Select the image you want to change, and then click Change Image.

4. To upload an image, in the Select image area, click Browse, then locate and select 
the image, and then click Upload.

If you have already uploaded the image you want to use, select the thumbnail 
in the Gallery.

5. Select the image you want to add to your template.

6. Click OK.

7. To change the way the image displays, from the Image Display list, select one of the 
following:

Tile Image
Tiles the image horizontally and vertically within the allotted space.

Preserve Original
Retains the original size and formatting of the image as allotted space allows.

Tile Horizontally
Tiles the image horizontally within the allotted space.

Tile Vertically
Tiles the image vertically within the allotted space.

Scale to Fit
Stretches the image so it fills the entire amount of allotted space.

8. To use the default template image, click Revert to Original.

9. Click Apply Changes/Update Preview to view your changes.

10. Click Save to update your live site with your changes.

Changing Your Blog’s Header and/or Footer
1. From the Design Blog menu, select Customize.

2. Go to the Header/Footer tab.

Quick Blogcast offers several different templates. Depending on the selected 
template, you update header/footer content using separate fields or in a 
WYSIWYG editor.
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3. If your header/footer content displays in multiple fields, edit any of the following:

Header Text
The text that displays in your site header.

Header Link URL (optional)
The URL that displays in your site header.

New window, Current window
Opens the specified URL in a new browser window or the current browser window.

Subheader Text
The text that displays below the header. This is often a subtitle.

Footer Text
The information that displays at the bottom of your Web page.

4. If the header/footer content displays in a WYSIWYG, switch between header and 
footer content by clicking either the Header HTML hyperlink or Footer HTML 
hyperlink, depending on which displays, and then edit using any of the following lists 
or tools:

If you prefer to use HTML, click the <> signs to switch to HTML-entry mode.

Normal
Select the formatting style you want to use.

Font Name
Select the font you want to use.

Size
Select the font size you want to use. The font size ranges from 1 to 6; 1 is the small-
est and 6 is the largest.

Bold
Bolds the text.

Italic
Makes the text italic. 

Underline
Underlines the text.

Strikethrough
Draws a line through the text.

Numbered List
Creates a numbered list.

Bulleted list
Creates a bulleted list.
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Increase Indent or Decrease Indent
Indent or decrease the amount of indented space for the paragraph.

Insert Table
Insert a table of a specified size into the header or footer.

Cut
Cut content from the page (which you intend to paste in a different location).

Copy
Cut content from the page (which you intend to paste in a different location).

Paste
Adds cut or copied content to the field.

Spell Check
Checks the spelling in the header and footer.

Insert Image from the Gallery
Insert an image from the gallery or upload your own custom image. 

Insert Link
Adds a hyperlink. Highlight the text you want to add a hyperlink to, click Create Link, 
select the type of link, and enter the link information. Click OK.

5. When finished, click Save. 

Customizing Your Template Using CSS
1. From the Design Blog menu, select Customize.

2. Go to the CSS Styles tab.

3. From the View Style Sheet list, select Customized CSS or Theme CSS.

4. In the Customized CSS file window, edit the CSS.

5. To view your changes in the preview window, click Apply Changes/Update 
Preview.

6. To update your live site with your changes, click Save.
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When you set up Quick Blogcast, your site automatically displays on the Internet as soon 
as it propagates. Propagation is a term describing the length of time it takes for all Inter-
net servers to recognize your site. 

New entries are not published until you explicitly save them in the Published status. See 
the Managing Blog Entries section for more information. 

If you’re making some changes to your blogs design, such as the colors it uses or the 
template images it uses, you must save these changes to make them live on the Internet. 

Quick Blogcast gives you the option of previewing your site as you make changes, show-
ing you how it displays on the Internet. This step gives you the option of making any 
changes before the site is actually published.

PREVIEWING YOUR SITE
You can preview your site at any time, to see how it would display on the Internet.

Any changes you make to your site display when you preview your site. However, your 
changes do not display on the Internet until you save them. 

To Preview Your Site
1. From the Design Blog menu, select Customize.

2. You can view your site in the preview window located in the center of the page.

3. To see any recent changes, click Apply Changes / Update Preview.

5. Previewing and 
Publishing Your 
Design Changes
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PUBLISHING YOUR SITE’S DESIGN
Congratulations! You are ready to publish your site. After publishing, your site updates 
display on the Internet.

To Publish Changes to Your Site’s Design
1. From the Design Blog menu, select Customize.

2. Make any necessary changes.

3. Click Save.
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Great job! Your new design changes are live on the Internet!
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Listed below are terms that are common in the world of blogging, podcasting, and blog-
casting.

GLOSSARY

Adsense, Adbrite, CJ, Chitka, Blogads
Popular affiliate programs used to generate money from your blogcast account.

Archives
A collection of all your posts on one page. Can be categorized by month or category.

Blog 
Shortened term of Weblog. A weblog is a journal (or newsletter) that is frequently 
updated and intended for general public consumption. Blogs generally represent the per-
sonality of the author or the Web site. A frequent and chronological publication of com-
ments and thoughts on the web.

Blogcast
A blog and podcast merged into a single website. 

Blogger
A person who owns or writes for a Weblog. 
A person who blogs.

6. Glossary
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Blogging
The act of posting on blogs.

Blogosphere
The Internet blogging community.

Blogroll
List of links to other blogs located in your sidebar.

Categories
A collection of topic specific posts.

Commentator
A person who leaves remarks or a comment regarding an entry in a blog.

Comments
Enabling readers to leave their remarks.
Remarks left by readers.

Del.icio.us, furl, spurl
Social bookmarks used to share favorite sites.

Entry
Individual articles that make up a blog

Expandable post summaries
A small teaser part of the post on the index page that links to a full post.

Flickr, Imageshack
Photo sharing services through which you can host images on your blog.

Footer
The bottom portion of the blog, usually listing navigation and copyright statements.
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Header
The top portion of the blog, usually listing the blog title.

Index page
The front page of your site.

Permalink
A link to a specific article in the archives of a blog, which remains valid after the article is 
no longer listed on the blog's front page.

Podcast 
A form of audio and video blogging that allows users to subscribe to a feed and receive 
new files automatically by subscription. 

Podcasting
A method of distributing audio and video files online. Podcasting often uses feeds for 
playback on mobile devices and personal computers. Podcasts are created by podcasters.

Post, Entry
Individual articles or audio/video posts that make up a blog or blogcast. 

RSS
RSS is a Web content syndication format. RSS is an acronym for RDF Site Summary, 
Really Simple Syndication, or Rich Site Summary. Using RSS, you can subscribe to Web 
sites, such as news sites and blogs, and add the subscription to your blog. Content, or 
posts, from the Web site you subscribe to display on your Web site. Subscription content 
updates in real-time, that is, when the author submits an updated post, your Web page 
reflects the update. 

A family of web feed formats used for Web syndication. Short form for Really Simple Syn-
dication (RSS 2.0), Rich Site Summary (RSS 0.91, RSS 1.0), RDF Site Summary (RSS 0.9 
and 1.0). Wordpress generates RSS 2.0 

RSS Feed
RSS feeds provide items containing short descriptions of web content together with a link 
to the full version of the content.
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Sidebar
One or more columns along one or both sides of a blog’s main page, usually used for 
links, calendars, or lists.

Social Bookmark
Social bookmarking allows user to take bookmarks suggested by others and add them to 
their own collections. Users can also receive bookmarks by subscription.

Spam
Spam refers to unsolicited online messages. Most Spam is used for marketing; however, 
Spam can also occur in the form of blog comments. This form of Spam is created by an 
author who posts a link in the comment, for commercial purposes.

Trackback
A trackback sends a ping to another Web site equipped for trackbacks, notifying the site 
that a new link has been created. Trackbacks notify the author of an entry that the post 
has been added to another blog. 

Web Feed
Allows users to subscribe to Web sites that regularly update or add new content.

Weblog
An online diary listing your thoughts on a specific topic, usually displayed in reverse chro-
nological order.
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